Creating a Captivate Movie - Part 1

By: Tom Green

This 3-part series is an excerpt from Tom Green's *Captivate Visual QuickStart Guide*. Published by peachPit Press it will be available in mid November.

Creating Captivate movies involves much more than simply doing a screen capture and "adding stuff here and there". Whether it is demonstrating a software technique, a product demonstration, quiz, or tutorial, the key to success is that old business adage: "Plan your work, work your plan."

Although Captivate is an extremely powerful software tool with a myriad of applications, never forget there will be a human watching the presentation. In this case, the message that the movie conveys, is far more important than the technology. Though you can add audio, animation, and other interactive media to your movie, always keep in mind that these features should add to the viewer's experience. The least successful presentations are those where the developer says, "Aren't I clever?!"

This chapter focuses on the movie creation process. This process starts with planning in many respects, the most time-consuming aspect of creating a Captivate movie. You'll learn how to record a movie, manage movies you have created, and create and use a Captivate template.

Creating a movie in Captivate is both uncomplicated and fast. Still, there is a work flow that follows these general steps:

1. Plan your movie using storyboards, scripts, and any other organizational material such as written notes or project planning software. Storyboards are especially useful because they can show the frame-by-frame progression of a movie, including audio, animations, mouse movements, and so on that will appear in the frame. Storyboards range from hand drawings on paper to PowerPoint presentations, for example, that lay out the content in the slide and describe its purpose.
2. Determine the playback media. Captivate movies can be played back from CDs, from hard drives, and through the Web. In each case, the final playback media will have a major role in determining the assets and recording of the movie.
3. Gather your assets. You can add images, sounds, animations and even other Captivate movies to your movie. Make sure these assets are readily available to you.
4. Open Captivate, set the recording options and, if needed, set the movie preferences.
5. Record your movie. The flexibility of Captivate enables you to record a movie from "scratch", utilize slides and animations from previously recorded movies, and even re-order the slides you have just recorded.
6. Adding the captions, images, sounds, and other assets called for in the storyboard.
7. Generate and preview the movie.
8. Save the movie as a Flash SWF file and export it in the format best suited to the media
Planning the Captivate Movie

The first rule of planning any interactive media project is this: "Focus on the user. Don't focus on the technology."

You are not the audience for the presentation. When planning a Captivate movie, the first step in the process is not to open the application but to ask yourself the following questions:

- Who is the audience? A movie designed for primary-school children will look and feel a lot different from one designed for software engineers.
- What does the audience need to learn from the movie? These are the learning objectives, and the fewer - two or three - the better.
- What is the audience's skill level regarding the content of the presentation? A presentation designed for people who have never used software will be a lot more basic than one designed for "power users". Knowing the audience's skills will also give you a good idea of the project's scope and complexity.

After you have determined the project's scope and understand the audience, you can then move into planning the movie's content. This is where the importance of a storyboard or script can't be understated.

Using Storyboards and Scripts

Storyboards use rough sketches to plan the progression of the movie. These can range in detail from a series of pencil sketches on a sheet of blank paper to full-color drawings created in drawing or imaging applications like Macromedia Freehand MX and Fireworks MX 2004. If you will be using lots of screen shots in your movie, with few captions or minimal text, a storyboard would work well.

Traditionally scripts are created using word processing software. Scripts enable you to describe, in depth, the contents of each screen and to present the movie in a logical, sequenced order. If your movie will contain numerous captions, text, voiceover audio, and so on, you should create a script.

Storyboards and the Macromedia Studio MX 2004

If you own Macromedia Studio MX 2004, you have three very powerful storyboard creation tools at your disposal—Freehand MX, Flash MX Professional 2004, and Fireworks MX 2004.

Freehand MX is a vector-drawing tool. One of the application's features is the ability to create multi-page documents. Also, you can use master pages which can hold commonly used elements, such as logos and headings, and apply them to any or all of the pages in your document. For example, the new "Connector" tool enables you to create flow charts showing the branching in quizzes, and the new "Action" tool lets you add basic Flash actions to a storyboard destined for the Web. You can also print out the storyboards and use them as client deliverables.

Flash MX Professional 2004, though aimed squarely at the Web coder, also contains a powerful storyboarding tool—the Slide Presentation. This feature allows even non-Flash users to quickly prepare an interactive presentation that can then be presented to the client for approval.

Fireworks MX 2004 is Macromedia's web imaging application. Apart from creating GIF animations that
can simulate each frame of a recording, you can use this application to optimize images used in Captivate. Further, the use of a symbols library in Fireworks allows you to reuse such items as logos and text without the inevitable file size increase.

Unlike RoboDemo, Captivate does include a "Storyboard View panel". The purpose of this area is not to let you plan your movie, but to rearrange the slides in the movie prior to its being published.

**Recording your movie**

Recording a movie in Captivate follows this general workflow:

1. Start the recording process.
2. Set the recording options, the full motion recording options, and the recording keys.
3. Record the movie.

**To record a new movie:**

1. Launch Captivate, and from the Start menu, click "Record or create a new movie". The "New movie options" window opens.

![Image 1: The Captivate Start Page](image)

2. Determine what type of capture you will be undertaking by choosing an option in the "Record new movie" area of the dialog box.

- **Application**: Choose to record everything you will be demonstrating in an application. The application must be open, and you will capture all movement within the application window.
- **Custom Size**: Choose to record the actions in a specific area of the screen.
- **Full Screen**: Choose to capture the entire screen. This is particularly useful if your movie moves between several open applications.
Two other movie types are available:

- **Blank Movie**: Choose to create a blank slide. It is useful if you will be copying slides from other Captivate movies and pasting them into this one.
- **Image Movie**: Choose to create a slide show.

3. Click OK to open the Recording window.
Image3: The Captivate Recording window and controls

**Tip**: You can't record a movie without Captivate being open. When you create a new recording, the Recording window will open, but you must then navigate to the application in which you will be recording the movie.

**To add new slides to an existing movie**

1. Open the Captivate movie to which the slides will be added and open the application in which you'll do the recording.

2. *Do one of the following:*

   - In the Storyboard View panel, either click the Record button on the Main toolbar or select Record Additional slides from the Slide Tasks to open the Recording window.

   *Or*

   - In the Edit View panel, click the Record button on the Main toolbar to open the Recording window.
3. Select whether the new slides should be appended automatically to the end of the movie, or added in at a specific place.

4. Click OK to open the Recording window.

**To set the recording options:**

The first step in recording a Captivate movie is determining what sounds will be used, whether auto recording is on or off, and deciding which interface elements will be visible during the recording. These are contained in the Captivate recording options. The interesting thing about these options is that you can set them before you record. You can apply them only to new frames added to the movie.

1. **Do one of the following:**

   In the Recording window, click the Options button to open the Recording Options dialog box.
Or:

- Open a Captivate movie then select **Options > Recording Options** to open the Recording Options dialog box.

2. Select the **Recording Options** tab to open the Recording Options dialog box (Figure 6) and then select your options.

![Image 6: The Recording Options](image)

**Tip:** You can apply the Recording Options globally without selecting a new movie or an existing movie. Select **Options > Recording Options** in either the Storyboard View or Edit View panels.

The Recording Options dialog box is divided into three distinct areas: Recording Options, Full Motion Recording, and Change Recording Keys.

Selecting the **Recording Options** tab reveals the following recording options:

- **Record narration** - Select to record any narration that may be done during the capture.
- **Hear "camera" sounds during recording** - Select to hear a camera shutter-release sound when the recording starts. This is especially useful if you are using auto recording. The sound is only an aural clue that the recording process has started; it won't be audible in the finished product.
- **Record keystrokes** - Select to record any key presses or text input as you record the movie.
- **Hear keyboard "tap" sounds** - Select to hear an aural clue that you are using the keyboard during the recording. These sounds will not appear in the finished movie.

- **Hide recording window** - Select to hide the red bounding box in the Recording window and to remove the Captivate icon from the task bar. This is especially useful for full screen recording or movies that incorporate the use of the task bar.

- **Hide task icon** - Select to remove the Captivate icon from the task bar.

- **Hide system tray icon** - Select to hide the system tray during recording.

- **Move new windows inside recording area** - Select to have any windows that may open during recording moved automatically inside the recording area. This is quite a useful feature when you're recording applications that require the user to see a number of windows or dialog boxes.

- **Enable auto recording** - Select to capture screen shots automatically each time the mouse is clicked, your application moves to the front, or you press a key on your keyboard. This option is enabled by default.

**Tip:** Other actions that will start an auto recording are clicking a capture key, opening a menu or dialog box, clicking a toolbar button or a button in a dialog box, and dragging and dropping.

- **Language:** Choose one of 13 languages for captions and tool tips.

- **Recording mode:** Four recording modes are available:
  - **Demo** - Select to include captions and highlights automatically to the auto-recorded movie.
  - **Simulation** - Select to include automatically click boxes with success and failure captions to the auto-recorded movie.
  - **Training** - Select to include rollover captions and click boxes during the auto-recording process.
  - **Custom** - Select to determine which elements are added to the auto-recording. Click the Edit Settings button to open the Custom Recording Options dialog box. After you make your choices, click OK.

**Image 7:** The Custom recording Options allow you to choose what gets added

Full motion recording is an automatic process in Captivate. It allows you to smoothly capture drag-and-drop actions, to capture mouse movement in the capture area, and to adjust the video quality of the capture.

The Full Motion Recording tab contains the following options:
- **Automatically use full motion capture for drag-and-drop actions** - Select to capture dragging objects from one area of the capture screen to another.

- **Show mouse in full motion capture mode** - Select to include mouse movement in the movie.

- **Record at higher full motion capture rate for smoother movie** - Select to disable any hardware acceleration during playback. The result of this is not a sped-up playback. Rather, it actually releases system resources that sometimes result in a "choppy" capture or "jerky" onscreen movements at playback. Selecting this option will cause your screen to flicker momentarily when you begin and end the recording as the acceleration is turned off and then turned back on.

- **Video Quality** - Enter a value that will determine the smoothness of the playback. As is typical with all digital media, the better the quality of the on screen material, the larger the file size.

- **Working Folder** - Click the Browse button to open the Browse for folder dialog box. Navigate to the folder to be used as the final location of the movie and click OK.

- **SWF Conversion** - Select the color depth of the SWF file. Selecting 16 Bit color results in a reduced color palette and a smaller file size. Selecting 32 Bit increases the color palette significantly and also results in a larger file size.

---

**Image 8:** The Full Motion Recording options let you decide how on screen motion is capture

Your final choice is to determine the key strokes that initiate and end a recording. You can set these keys by selecting the "Change Recording Keys" tab and making choices in the "Change Recording Keys" dialog box.
You can set which keys start and end the recording process

Your choices are as follows:

- **To stop recording press:** - The default is "End". If you want to change it, select the choice and press a new key or key combination.
- **To manually capture a screen shot press:** - The default is Print Screen.
- **To start full motion recording press:** - Press F9 after the recording starts to initiate this action.
- **To stop full motion recording press:** - Press F10 to stop a full motion recording.

To set the capture area manually

You aren't limited to the area defined by the red capture box when you start the recording process. You can change the size of the recording area. Here's how:

1. Select File > "Record or create a new movie" if you are working with a previously recorded movie, or click "Record or create a new movie" on the Start page. The New Movie Options dialog box opens.
2. Select Application and click OK. The Recording window opens.
3. From the "Record specific window" pop-down list, select the application in which you will be recording. (Figure 10). The application window to be recorded opens.

![Image 10: The window to be recorded is selected.]

4. Drag a resize handle (the eight squares on the edges of the capture box) inward to shrink the bounding box or outward to grow the bounding box.

![Image 11: The handles can be moved to resize the recording area]

5. Click and drag the red line, not a handle, to move the bounding box to another screen location.

Tips:

- If you make a mistake, click the Cancel button in the recording controls to return to the Captivate interface.
- Clicking the "Snap red recording area to fit selected window" button will expand the red recording box to the dimension of the open window and thus defeat the purpose of this exercise.
- If the window to be recorded is larger than the recording area, select the window from the list in the "Optionally select a window you'd like to record" pop down and click the "Snap window to fit inside the red recording area" button.

If your movie is destined for Web playback, consider these suggested capture screen sizes for efficient playback:

- 28.8 kbps modem: 640 x 480
- 33.6 kbps modem: 800 x 600
- 56 kbps modem: 800 x 600
- DSL, cable, T1: 1024 x 768
To record a movie

1. If necessary, adjust the recording area or move the recording area bounding box to its final position.
2. Click the Record button.
3. Perform your actions within the bounding box.
4. Press the End key to stop recording. You will be returned to the Storyboard View panel, where your new movie will be available as a series of thumbnails.

**Tip:** If you want to pause the recording process, press the Pause/Break key on your keyboard. To resume recording, press the Pause/Break key again.

To preview your capture

1. Open the Storyboard View or Edit View panel.
2. Click the Preview button on the Main toolbar. The resulting pop-down menu contains the following options:
   - Movie: Choose to Preview the entire movie.
   - From this slide: Choose to have the movie play from the selected slide to the end of the movie.
   - Next 5 Slides: Choose to play a small six-slide segment of the movie.
   - In Web Browser: Choose to compile the movie and play it back in your browser.
3. After you make your choice, a "Generating progress" dialog box opens. Once the movie has been compiled, the Preview window opens and the movie starts to play.
4. To return to the Storyboard View or Edit View panel, click the "Close preview" button.

**Tip:** Use the Preview feature to review any changes you will make to your slides. The playback matches that of the final file, meaning this is the place to identify problems and address them. You can also use the playback control in the window to pause the movie and move between slides.

**Image 12:** The Preview options

**Tip:** Use the Preview feature to review any changes you will make to your slides. The playback matches that of the final file, meaning this is the place to identify problems and address them. You can also use the playback control in the window to pause the movie and move between slides.

**Tomorrow:**

In the next installment of this chapter, I will show you how to create and use Captivate Templates, change the properties of a movie you have created and how to resize a Captivate movie before it is published.

Approximate download size: 303k